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A. Starting Up 

1. Double Click on Easy Grade Pro Icon  
2. Click on Create a New Grade Book  
3. Locate your Storage location  

o Default location is the computer hard drive 
o Choose your floppy disk or flash drive  

 

B. Entering Class Names 
Click Add Classes 

1. Enter Name of your First Class  
2. Check Terms  
3. Can Edit Term 1 so it says Quarter 1 etc.  
4. Type in your name  
5. Do this for each class you teach  
6. Click Done when finished 

 

C. Editing Class Options     

1. Select a class from the Choose a Class drop down menu 
2. Click View/Edit Class Options (or go to Edit/Class Options) 
 
Grade Scale Options- these can be customized to anything you want 
 
1. 3 grading scales are listed 
2. You can adjust the numerical scale if you wish 

 

Rounding Options 
 

Choose the way you want numbers rounded:  
  whole number      89.515- 90% 
 tenths place         89.515- 89.5% 
 hundredths place  89.515- 89.52% 
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Score Category Options-allows you to weight types of assignments 
 

1. If desired, click yes under use category weights 
2. Under weight, click % and adjust as necessary 
3. Add any other extra categories as desired:  
           Labs, oral quizzes, participation 
4. Make tests and quizzes separate category 
5. Ex. If you weight tests as 50%, make sure all other categories add up to 
100% 
6. Remember, Easy Grade Pro uses maximum score to calculate a student’s 
percentage grade on an assignment. Ex. 7 of 10 possible max points= 70% 

 
 
* When you enter grades you must enter a category for the grade     
(i.e. Test, Homework)  

1. Can change these to whatever you desire  
2. Be sure you remove unnecessary categories  
3. Unweighted grades-all points added together and then averaged (total 

divided by points possible)  
4. Weighted--each category is averaged---then multiplied by a factor 

according to your weighting and then average. For example: 
o You have 3 categories of grades: Tests, Homework, Research 

Paper  
o You assign Tests as 50% of the Grade, Homework as 25% of the 

Grade and Research Paper as 25% of the Grade  
o The program will multiply the test average by 2, add this to the Homework 

Average, add this to the Research Paper average, and then divide this sum 
by 4. 

 

Footnote Options-can be attached to individual student scores to provide 
additional meaning to a grade 

1. These comments can be included in student progress reports  
2. Footnotes can be attached by double clicking on a score cell and then 

selecting the footnote from a prepared list OR 
3. You may type your own footnote  
4. Footnotes show as a small number in lower left-hand corner 
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Special Scores 

1. Non-numeric scores such as ex(excused), inc (incomplete)  
2. Can have up to 30 special scores  
3. These are not grades  
4. Value: 

    must be between 0 and 100%.  
    Keep it blank if you want the score to have no impact on the student's       
grade  

5. Check the “Count as Missing” box if you want the special score’s value to 
be the equivalent of a missing assignment (0) 

6. Use “ok” for a check assignment 
7. Can drop scores by putting ”dr” into box 
8. If you do this, the score is automatically not calculated 

 

Attendance Category Options 
 

1.  This sets the options for the attendance chart   
     2.  Codes are listed; they can be changed to something  
 more familiar, such as: 

Ex for excused absence 
Un for unexcused absence 
Su for suspension 

 

 

Calendar Options       

1. Allows you to set the days the class meets, the starting and 
ending dates for the class and holidays  

2. To change the month, click on one of the two arrows at the 
top of the calendar  

3. To change the year, click on the year and set the new year  
4. Set Dates for Start and End of Term (required)--just click on 

the date  
5. Can Check days school will not be in session 
6. You will have to set the calendar for each term 
7. Do this by selecting a class in another term and setting the calendar  

http://www.verypdf.com/
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Combine Terms-(You can not do this until you have at least two 
quarters worth of grades recorded) 

1. This is used to average the grades of two or more terms. For example if 
this is quarter 4, you can combine this with data in quarters one, two and 
three to produce an overall grade.  

2. You can not do this until you have completed at least 1 term. You need to 
wait until the end of the last term you want combine.  

It is best to choose term weights if you want to ensure that each 
term has the desired value. You choose term points if you want the 
current term to be a direct continuation of the prior term. You can't 
use term points if any of the classes to be combined uses score 
category weighting. 

 

Seat Format-Allows you to create a seating chart  

1. Change shape of seats by dragging box at the lower 
right corner of the sample seat 
2. Change name and attendance format of seats by 
clicking the radio button next to the way you would like it 
displayed i.e. 1 line info, 2 line, etc. 
3. Additional options- like color and rotation set in actual seating chart 
4. Note-print a paper attendance form to leave for a substitute to 
take attendance quickly and accurately 
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Color Option 
1. Edit/Class Options/Colors tab 
2. Pick a background color  
3. Pick a grid color 
4. Click ok to set the new colors 
  
****Remember: Click Edit/Class Options if you want to change 
class options later on**** 
 
IMPORTANT NOTE: 
Copy Class Options 
1. You need to enter the information above for each class you teach BUT 
you only have to do it once (if you use all the same options)  
2. From the Tools menu/select Copy  
3. HIGHLIGHT Class Options  
4. Click on Class to Copy From  
5. Select Options to copy--individually or Select all list items  
6. Click Copy 
7. Click Yes 
 
D. Adding Student Names   
1. Click Type Student Names  
(After the first time you enter the names each year 
you may want to click Copy Students from the PRIOR 
TERM) 
To do this, select the next term and click Copy 
Students from the Prior Term 
2. Enter the desired information 
3. Optional: Enter the ID by typing it or have it set 
automatically---if you intend to post student grades, you should give each 
student and ID and then tell the student the ID privately.  
4. Optional: Change the student's grade scale--will automatically assign the 
first grade scale to a new student. However, you can assign a different 
grade scale by pressing on the pop-up menu 

Please register PDFcamp on http://www.verypdf.com/, thank you.
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5. Optional: Change the student's report language (English, Spanish or 
French)  

6. Optional: type additional student information  
7. Press RETURN or Click >> to move to the next record  
8. When finished entering names click DONE  

 

 Importing Student Names from a list in Microsoft Excel 
 
  1. Open file in Excel 
  2. Highlight names and save as Text (tab delimited) 
  3. Open Easy Grade Pro 
  4. Choose New Class 
  5. Click Import 
  6. Format Name: choose last name <space> first 
  7. NEXT button is highlighted 
  8. Click Next 
  9. Transfer complete 

 

E. Gradebook Options-allows you to modify and set options to suit 
specifications in your gradebook  

 

1.  Display options- 
                 Font-sets font and font size 
                 Highlight-sets row and column highlight 

http://www.verypdf.com/
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                 Show students-sets order of student’s name in charts and reports 
                 Show grades- set display of grades in the charts 

2.  General options- 
                 Choose to allow typing of special scores 
                 Choose to have program give you a warning when score exceeded 
                 Choose scroll options 
                 Choose tool palette options 
                 Compression options-do not use this 
                  

 

 

3.  Security Options-It is highly recommended that if a teacher sets a    
security password for his gradebook, he should remember the 
password! 

 
  Set Teacher Password- you will enter password in two boxes 
 
  Set TA password- can set a password for someone else to use 
 
  Password Protect- lock gradebook on quit or when you select lock 
                
                 When close or quit- allows you to set type of backup prompt that                               
appears when you close or quit your gradebook 
 
  Allow TA to- set access privileges for a TA 

http://www.verypdf.com/
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G. Entering Scores 

1. All scores must be entered directly into cells in the score chart 
2. Blank cells are ignored and have no effect on a student’s grade  
3. Typing Scores  

o The most common way to enter data  
o You can type numbers from zero through 999.9  
o After typing the data press return or enter to go to the next cell 
o To repeat a score (copy the score from the cell above) press the = 

key  
o If you type a score that is greater than the maximum score for the 

assignment, a window will appear asking you if you made a 
mistake 

4. Grade-Clicking-  Edit/Tool Options/Show Tool Options  
o You can also enter data by grade-clicking.  
o This is by clicking on a grade on the tool pallet 
o Simply click a grade or score on the palette  
o After clicking, Easy Grade Pro will automatically scroll down  
o To calculate the students grade Easy Grade Pro will use the number 

you assigned to the Grade-Click option when you were setting up 
your grade book  

Adding Extra Credit      

1.  Extra credit can be added in two different ways: 

 by increasing a score on an assignment or  
 by adding an assignment column to be used just for extra credit  

2.  By increasing a score--simply add the desired number of points to the 
student’s score. Typically, this will cause the student to receive a score 
that is greater than the maximum score for the assignment. 
  
3. Giving Extra Credit by adding a new column--Begin by adding an 
assignment in the normal way  
 
4.  In the assignments' record window, choose Extra Credit from the 
Special Status pop-up menu 
  
5.  As soon as you do this, the text fields for entering the assignment's 
maximum score and points will disappear 
  
6.  Complete the assignments; record.  
 

Please register PDFcamp on http://www.verypdf.com/, thank you.
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H. To Show Missing Grades (Using Filters) 

1. Select the Filters Menu  
2. Select Missing-this report can be printed if you want  
3. There are many ways to filter data: show missing, blanks, F’s, improvers, 

decliners, top 10 
4. Can create your own filter by clicking View/Edit Filters/New Filter  
5. To get back to the grade book page--go to Filters Menu and Show All 

I. Reports        

1. Open class 
2. Select Print from File Menu  
3. Enter Teacher Name 

 
4. Select the Report you want  

o Multiple-Class report-designed for teachers with 
the same students in more than 1 class; e.g. elementary teachers 
who may list all subject grades for all students  

o Single-Class report-designed for teachers with different students 
in each class; MS/HS teachers would use this form of report for 
each class section 

o Missing Work Report-the missing work report can be used to 
report to students and parents about missing assignments; you can 
even make a poster so everyone knows what is missing 

o Class roster-blank grid for scoring orals, participation or any 
project work such as labs 

o OR click Chart tab and choose from Score, Assignment or 
Attendance 

o Attendance Gradesheets-list students, dates and attendance 
marks.  

o Scores Gradesheets-lists students, assignments and scores. It 
can be set up to include blank rows and columns and then be used 
as a customized paper gradebook. It is suggested to use the Page 
Setup to set the orientation to landscape view and to set a 
reduction of around 60% to 80%; this will maximize the number of 
columns per page.  

o The Score Chart is what you use to print the final averages of 
your students in one class 

o If you’re not sure, check the print preview first before 
printing (it saves paper!) 
 

5. Select the Print button---the standard print window will appear  
6. Click Print  

Please register PDFcamp on http://www.verypdf.com/, thank you.
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J. Main Programs Tabs…Score, Attendance, Seating, Student, 
Assignment 

1.  Score-information found in other locations in this booklet 
2.  Attendance- allows you to view, record and edit attendance data for a  
single term 
  *You must set a calendar and attendance options first 
    Each column is a single date 
    Grayed dates are non-school days 
    Can type or use codes at top to enter data 
3.  Seating-allows you to set up a seating chart to match your classroom 
     Attendance can be taken directly from seating chart 
             Can change rotation of furniture and color 
     Highlight a group of items and change them all at once 
4.  Student-allows you to view and sort by various data 
     You may enter data here such as parental contact info 
5.  Assignment-allows you to see class assignments at a glance 

 

K.  Mini-Summaries-allows you to view data in graphical form  

1. Upper left corner  
2. Data presented for individual student performance, class performance, or 
class performance on a specific assignment 
3. Within these categories, the results can be viewed as graphs, charts, 
scores, attendance, notes or comments 
 

 

L. Back Ups      

*VERY IMPORTANT* 

1. Always back up your grades  
2. When you work, program automatically saves all of 

your work 
3. By default, when you close program it asks if you want 

to make a backup copy  
4. Click on Yes to make a back up  
5. Insert a disk or better yet, a usb flash drive  
6. Navigate to that disk location 
7. Change name from “copy of copy of…” to current date  
8. Click Save 

Please register PDFcamp on http://www.verypdf.com/, thank you.
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9. You should also make a backup copy to your z drive 
10. Navigate to your folder (z drive) and name the backup by using the date. 

You might want to delete OLDER backups so you won’t be 
confused. 

N. Passwords 

1.  You really SHOULD NOT password protect your gradebook 
2.  If you forget your password, there are very few options 
3.  Supposedly, if you forget your password, only the network administrator 
can call the company to receive a special one-day password that will allow 
you to open the gradebook and set a new password. 
4.  If you really want to use security, please see Gradebook Options 

 

REMEMBER: Your media specialist has several copies of the 
Easy Grade Pro manual available for your use. 

FAQ  

What are maximum score and points? How should I set 
them? 

By definition, an assignment’s maximum score is the score that is worth 100%. 
It’s the score that is given when everything is correct (ignoring extra credit). 
Perhaps you like to score papers using percents (scores between 0 and 100). In 
this case, as a percents grader, you should keep the maximum score at 100. 
Perhaps you count the number of problems the student has correct to get the 
score. In this case, as a problems-grader, you should set the maximum score 
to the total number of problems. Perhaps you apply differing amounts of points 
to problems based on difficulty and then sum the points the student has earned 
to get the score. In this case, as a points-grader, you should set the maximum 
score to the number of points possible on the assignment. 

Easy Grade Pro uses the maximum score to do one thing only: calculate a 
student’s percent on the assignment. If a student’s score is 15 and the maximum 
score is 20, Easy Grade Pro calculates (15/20) x 100 and gets 75%. Notice that 
the maximum score has nothing to do with the value of an assignment. A 
student can have a 15 out of 20 on a small assignment as well as on a huge 
semester project. How is one assignment given more value than another? It is 
done through the use of assignment points! 

Please register PDFcamp on http://www.verypdf.com/, thank you.
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By definition, an assignment’s points is the number of points to be earned when 
a student’s score is equal to the maximum score. Using the example above in 
which the student’s score is 15 out of 20, the student will get 75% of whatever 
value is set for points. The student will receive 15 points if there are 20 points 
possible, 75 points if there are 100 points possible, 150 if there are 200 points 
possible and so on. 

So, how should you set an assignment’s points? The answer depends on your 
grading style. If you are a points-grader, you should use the same number for 
maximum score and points. When you do this, the student’s score, whatever it 
is, will be equal to the number of points earned. If you are a percents-grader 
or a problems-grader, simply keep the points set at 100 for a typical 
assignment, 200 for an assignment worth double, 50 for an assignment worth 
half and so on. 

How can I drop more than one score for each student? 

Because Easy Grade Pro drops scores in real time (as scores are entered) in a 
way that ensures the student’s grade is improved the most, it can only drop one 
score automatically. 
 
However, it is possible to have more than one score dropped using the Change 
Scores tool. First make sure that you have at least two assignments with status 
of Can be Dropped. Then choose Change Scores from the Tool menu. In the 
Change Scores window, set the first menu to Dropped Score and the second 
menu to ‘dr’. Click Change. The small letter ‘d’ will be replaced by the ‘dr’ and a 
new automatic drop calculation is made. Be sure to note that ‘dr’ is a special 
score that has no value and will replace the numeric score.  

How do I set or edit term options? 

1 Switch to a class in your current term. 
2 Choose Term Tools->Combine Terms from the Tool menu. The Term view of 
the Class Options window will open (shown above). 
3 You must decide to combine your term data using weights or points. Select 
weights if you want each term to have a set value. Select points if you want the 
terms to be combined by summing all the points that a student has earned.  
4 Choose to match the students across classes by ID or name. Each student’s ID 
number or name must be completely identical in all terms.] 
5 Carefully select the prior-term classes by pressing on one or more menus 
below the name of the current class. When selecting classes, you must choose 
between combining the term or the overall grade. Choose Term. 

Please register PDFcamp on http://www.verypdf.com/, thank you.

http://www.verypdf.com/


 EGP 16 

6 If you have selected Combine grades using weights, enter the term weights in 
the Weights column. They must sum to 100%. 
7 Click Done. Easy Grade Pro will go to each of the prior-term classes and try to 
match the students. Whenever a match is found, the student’s points, grade and 
attendance totals for that term are copied to and combined with the current 
class. A window will appear listing any students that could not be found in prior 
terms. 

Why does “copy of…copy of…” show up every time I try to 
save a gradebook? 

Easy Grade Pro saves automatically. In Easy Grade Pro’s File menu, there is no 
Save command; you never manually save your work. However, there is a Save 
Copy command. When you close a gradebook, there is a prompt for saving a 
copy. Always make a copy of your gradebook, but remember this is only a 
backup copy to be used during an emergency. You will never open it unless 
something happens to the original, but keep it in your "safe" just to be safe! 
Instead of letting the program name it (copy of…copy of…) put on the current 
date. 

 

Other resources: 

http://www.learningelectric.com/easygradepro.htm 
(quicktime movie tutorials) 

http://www.svusd.k12.ca.us/schools/mvhs/documents/EGPUsermanual.pdf 
(the entire manual in adobe format) 

http://docushare.everett.k12.wa.us/docushare/dsweb/View/Collection-72 
(a series of Windows movies to show you how) 
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